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System Resources 

 

Tap one of these icons to show the System Resources window for MPC X or MPC Live. 

 

 
 

The indicators in this window show current usage statistics: 

Battery: If you are using MPC Live powered by its internal battery, the first indicator shows the current battery 
life as a percentage. (See Battery Usage to learn more about MPC Live’s internal battery.) 

CPU: The CPU indicator shows the current CPU as a percentage. 

RAM Usage: The Mem indicator shows your MPC hardware’s current RAM usage. 

Important: If you encounter a warning that there is not enough memory to complete an action while using your 
MPC hardware, do the following to make more memory available: 

Make sure all audio tracks in your project are not record-armed. 

Delete samples from your project’s sample pool that were there before the warning appeared. 

If you are still seeing the warning, do the following: 

1. Manually undo the last action you performed before seeing the warning (you may not be able to use the 
Undo button for this due to how the undo history is stored in RAM). 

2. Save your project. 

3. Do one of the following, and then load your saved project again. 

•     In Main Mode, tap the folder icon at the top of the screen, and then tap New at the bottom of the screen. 

•     Power your MPC hardware off and then on again. 

•    Press Menu and then tap the gear icon to open the Preferences. In the Preferences, tap Reset at the 
      bottom of the screen, tap OK, and then tap Restart to reset the Preferences. 

•     Enter Controller Mode and then reenter Standalone Mode. 

Important: Although you can load multiple files at once, any samples you load into a project will be automatically 
converted to full-quality uncompressed audio files, so they may use more storage space than they do on your 
external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again. 

Drives: The Drives indicator shows the available storage space on any detected external storage devices or the 
internal drive of MPC X or MPC Live. 

 

To delete samples from the project (to create more free RAM space for sampling time, audio recording, etc.), tap 
Purge. In the screen that appears, tap Unused Samples to delete all unused samples from the project, tap All 
Samples to delete all samples from the project (from all programs, sequences, and audio or MIDI tracks), or tap 
Cancel to return to the previous screen. 

To close the System Resources window, tap OK, the X in the upper-right corner, or anywhere outside the window. 
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Time Counter/Locate 
 

In most of the available modes, there is a time counter at the top of the screen. This indicates 
the current playhead position. 

 

To adjust the position, tap it, and then use the use the data dial or the –/+ buttons. 

 

To open the Locate screen and adjust its settings, double-tap the time counter. 

To close the Locate screen, tap the X in the upper-right corner or anywhere outside the 
window. 

 

 

 

 

To move forward or backward a step, tap the Step < or Step > button, respectively. 

 

To move forward or backward a bar, tap the Bar << or Bar >> button, respectively. 

 

To configure your auto record settings, use the Auto Record selector and adjacent fields: 

Auto Record selector: Tap the desired option to select it: 

Off: Auto recording is disabled. 

Punch In: You can auto record using punch-in and punch-out markers, enabling you to record over a 
specified length of time in the track. While recording, the entire sequence will play, but you will record over 
only the area between the Punch In and Punch Out markers. Any part of the sequence before the Punch In 
marker or after the Punch Out marker will remain untouched, even if you perform over it during recording. 

Record Start: After you record-arm the track and start playback, you will start recording once the sequence 
loops back to its start. This is essentially a punch-in feature for the entire track, enabling you to start playing a 
record-armed track while allowing more time than the usual count-in to prepare for the actual recording to start. 

Punch In: Use these fields to set the location of the Punch In marker, which is where recording will start (when 
the Auto Record selector is set to Punch In). 

Punch Out: Use these fields to set the location of the Punch Out marker, which is where recording will stop 
(when the Auto Record selector is set to Punch In). 
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You can use this screen to set time markers, allowing you to jump automatically to precise locations in a sequence. 
You can set up to six time markers. 

To set a time marker, tap the time counter at the top of the screen, find the desired time, and then tap Set next to 
the desired time marker. The time will appear next to that marker. 

To jump to a time marker, tap the number next to it (1–6). 
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Timing Correct (TC) 
 

The Timing Correct window contains various settings to help quantize the events in your sequence. You can 
quantize note events on MIDI tracks or track regions on audio tracks (though you cannot apply all types of 
quantization to audio tracks). 

To open the Timing Correct settings: 

In Main Mode or List Edit Mode: Tap the TC/clock icon at the top of the screen. 

In the Grid View: Press and hold Shift and tap TC at the bottom of the screen. 

In the Track View or the Step Sequencer: Tap TC at the bottom of the screen. 

Note: The TC button in Pad Mute Mode and Track Mute Mode contain Timing Correct settings, but they do 
not open this window. See Modes > Pad Mute Mode and Track Mute Mode to learn about those settings. 

To apply the settings you selected to the current track, tap Do It. 

To apply the settings you selected to all tracks, tap All Tracks. 

To cancel and return to the previous screen, tap Close. 

 

  

 

Use the Type selector to set how timing corrections are applied. 

Start: The entire note event or audio track region will be nudged forward or backward so the start point aligns 
with the closest time division marker in the grid. You can apply this to MIDI tracks or audio tracks. 

End: The end points of note events will be extended or shortened to align with the closest time division marker in 
the grid. The start points will remain untouched. You can apply this to MIDI tracks only. 

Length: The end points of note events will be extended or shortened so that each event’s length is a multiple of 
the time division, regardless of where it is in the grid. The start points will remain untouched. You can apply this 
to MIDI tracks only. 

Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase from the 
first note event’s start point to the last note event’s end point. Each note event will sustain until another note event 
starts. If multiple note events start at the same time (and are not the last note events), their lengths will become 
identical. Selecting Legato disables all other options in this window. You can apply this to MIDI tracks only. 

  
Without legato applied. With legato applied. 
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Use the Time Division selector to set the quantization value. Events will “snap” to these time divisions on the grid. 
The T indicates a triplet-based value. 

Alternatively, press and hold Note Repeat while in Main Mode, and then use the six buttons at the bottom of the screen. 

 

Use the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle 
to extreme. 

 

Use the Shift Timing field to shift all events by clock ticks.  

 

Use the Window field to set how many events around a quantize value will be quantized. Any events outside this 
range will not be quantized; events inside will. 

 

Use the Strength field to set how strictly events will be quantized (i.e., shifted toward the quantize value). Lower 
values move events a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict 
quantization (a higher value). 

 

Use the Events selector to set the target range for the 
time correction. You can apply the time correction to All 
note events or to just the Selected ones. 

To select note events to which to apply time correction, 
either use the various tools in Grid View or press the 
pad with the desired events (while Hitting Pad Selects 
All Events is set to On). You must do this before 
opening the Timing Correct window. 

When Range is selected, you can define the locations 
(From and To) as well as the pads or keys that will be 
quantized. 
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Automation 
 

You can set the automation for programs and audio tracks to be “written,” “read,” or disabled entirely. You can do 
this globally or for individual programs and audio tracks. 

 

 

Global 

 

In several modes, there is a button in the upper-right corner that controls the global automation. When you tap this 
button to change its state, it will change the automation state for all programs in the project. 

This is available in Main Mode, XYFX Mode, Pad Mute Mode, the Pad Mixer, the Channel Mixer, and Q-Link Edit Mode.  

 

Tap the global automation button to cycle through its three states: 

When off, automation data will be ignored. If you have already recorded or entered automation, 
tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off 
by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still use the effect 
and its parameter values at the point where you turned it off. 

When set to Read (R), automation data will be read but not recorded. (Think of this as a protective 
feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), automation can be recorded and will overwrite any existing automation. (Make 
sure not to touch the XY pad accidentally while you are recording.) 

 

 

Programs & Audio Tracks 

 

You can also set the automation for each program or audio track by using the program automation button in the 
channel strip on the left side of the screen in Main Mode and the Channel Mixer. Program automation is available for 
all program types except MIDI programs. 

Note: Remember that tapping the global automation button will change the automation state for all programs in the 
project; if they were originally different, all of them will then match the global automation state. 

In Main Mode, if the channel strip is not already shown, tap the small eye icon below the Project field to show it. 

In the Channel Mixer, if you do not see a program automation button in the channel strip, make sure the Mixer field 
is set to Audio Tracks or Programs. 

 

Tap the program automation button or press Read/Write (MPC X) to cycle through its three states: 

When off, the program will ignore automation data. If you have already recorded or entered 
automation, tapping this will switch between Read (R) and Write (W) only, but you can override 
this and turn it off by pressing and holding Shift while pressing or tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still use the effect 
and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record any additional 
automation over it. (Think of this as a protective feature to prevent accidental changes to your 
automation while recording.) 

When set to Write (W), the program can record automation. (If you have any Q-Link knobs assigned 
to automatable parameters, make sure not to touch any accidentally while you are recording.) 
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Insert Effects 
 

Pads 

You can load up to four insert effects to each pad. You can do this in Main Mode, the Pad Mixer, or Program Edit Mode. 

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply 
unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this 
with a program insert effect (see Insert Effects > Programs). 

 

 

 

To load a pad insert effect in Main Mode: 

1. When the MIDI tab is selected (in the lower-left corner), use the Track field to select the track that uses the 
program with the desired pad—the program it uses will be selected automatically. 

2. If the channel strip is not already shown, tap the small eye icon below the Project field to show it. 

3. Tap the single-pad icon at the top of the channel strip. The channel strip will now show settings for the current pad. 

4. Press the desired pad to select it. Alternatively, use the Pad field at the top of the channel strip. 

5. Tap the area under Inserts, and then use the screen that appears to load or edit effects. 
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To load a pad insert effect in the Pad Mixer: 

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at 
the top of the screen to select the desired track—the program it uses will be selected automatically.  

2. Press the desired pad to select it, or tap it on the screen. Alternatively, double-tap the Pad field below the 
Program field. 

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert 
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired 
pad on the screen. You could also use the data dial or –/+ buttons to select an effect immediately. 

 

 

 

 

To load a pad insert effect in Program Edit Mode: 

1. While using the desired program, press the desired pad to select it. 

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects. 
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Keygroups 

You can load up to four insert effects to each keygroup. You can do this in Main Mode, the Pad Mixer, or Program 
Edit Mode. 

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you 
load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.  

 

 

 

To load a keygroup insert effect in Main Mode: 

1. When the MIDI tab is selected (in the lower-left corner), use the Track field to select the track that uses the 
program with the desired pad—the program it uses will be selected automatically. 

2. If the channel strip is not already shown, tap the small eye icon below the Project field to show it. 

3. Tap the single-pad icon at the top of the channel strip. The channel strip will now show settings for the current 
keygroup. 

4. Press a pad to select its corresponding keygroup, or tap it on the screen. Alternatively, use the Keygroup field at 
the top of the channel strip. 

Important: Remember that the effect will be applied to that keygroup only. 

5. Tap the area under Inserts, and then use the screen that appears to load or edit effects. 
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To load a keygroup insert effect in the Pad Mixer: 

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at 
the top of the screen to select the desired track—the program it uses will be selected automatically. 

2. Press a pad to select its corresponding keygroup, or tap it on the screen. Alternatively, use the Keygroup field 
below the Program field. 

Important: Remember that the effect will be applied to that keygroup only. 

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, double-tap 
the desired pad on the screen. You could also select one of the four Insert tabs at the bottom of the screen, and 
then use the data dial or –/+ buttons to select an effect immediately. 

 

 

 

 

To load a keygroup insert effect in Program Edit Mode: 

1. While using the desired program, press the desired pad to select its keygroup. Alternatively, use the Keygroup 
field at the top of the screen. 

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects. 
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Programs 

You can load up to four insert effects to each program. You can do this in Main Mode, XYFX Mode, and the Channel 
Mixer. 

Note: In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name of the insert 
effect that is loaded when use this mode. 

 

 

 

 

To load a program insert effect in Main Mode: 

1. When the MIDI tab is selected (in the lower-left corner), use the Track field to select the track that uses the 
program with the desired pad—the program it uses will be selected automatically. 

2. If the channel strip is not already shown, tap the small eye icon below the Project field to show it. 

3. Tap the four-pads icon at the top of the channel strip. The channel strip will now show settings for the current 
program. 

4. Tap the area under Inserts, and then use the screen that appears to load or edit effects. 
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Submixes 

You can load up to four insert effects to each submix. You can do this in the Channel Mixer only. 

 

 

 

To load a submix insert effect: 

1. Use the Mixer field in the upper-left corner to select Submixes. 

2. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Submix 
field below the Mixer field and tap the desired program. 

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert 
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired 
pad on the screen. You could also use the data dial or –/+ buttons to select an effect immediately. 
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Masters 

You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4, 
etc.). You can do this in Main Mode or the Channel Mixer. 

 

 

 

 

To load a master insert effect in Main Mode: 

1. If the channel strip is not already shown, tap the small eye icon below the Project field to show it. 

2. Tap the crown icon at the top of the channel strip. The channel strip will now show settings for the current 
master output. 

3. Use the Outputs field at the top of the channel strip to select the desired master output (Outputs 1/2, Outputs 
3/4, etc.). 

4. Tap the area under Inserts, and then use the screen that appears to load or edit effects. 

 

 

 

 

To load a master insert effect in the Channel Mixer: 

1. Use the Mixer field in the upper-left corner to select Masters. 

2. In the touchscreen, tap the pad that corresponds to the desired master output (Outputs 1/2, Outputs 3/4, etc.). 
Alternatively, double-tap the Outputs field below the Mixer field. 

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert 
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired 
pad on the screen. You could also use the data dial or –/+ buttons to select an effect immediately. 
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Send/Return Effects 

 
Send/return effects work in the following way: 
1. A pad, keygroup, audio track, program, or submix sends its audio to a return at a designated send level. 
2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and 

activated. 
3. The processed audio is sent to a pair of master outputs (stereo) or a single master output (mono). 
 
You can load send/return effects and set return levels only in the Channel Mixer, described below. The rest of this 
section describes the different ways to set the desired send levels for pads, keygroups, programs, or submixes. 
 

 
 
To load a send/return effect to a return: 
1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Returns. 
2. In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the Return field 

below the Mixer field. 
3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert 

tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired 
pad on the screen. You could also use the data dial or –/+ buttons to select an effect immediately. 

 

 
 
To set the return level: 
1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Returns. 
2. Tap the Level tab in the lower-left corner. 
3. In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the Return field 

below the Mixer field. 
4. To adjust the level of the currently selected return, use the data dial or –/+ buttons. Alternatively, use the 

level slider in the channel strip, or turn the corresponding Q-Link knob. To make finer adjustments, double-
tap the pad on the screen and adjust the larger version of the slider that appears. 
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Pads 

You can set the send levels for pads in Program Edit Mode or the Pad Mixer. 

 

 

 

 

To set the send levels for a pad in Program Edit Mode: 

1. While editing the desired program in Program Edit Mode, press the desired pad to select it. 

2. Tap the Effects tab in the lower-right corner. 

3. Use the Send knobs to set the send level for each return. 

 

 

 

 

To set the send levels for a pad in the Pad Mixer: 

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at 
the top of the screen to select the desired track—the program it uses will be selected automatically. 

2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level). 

3. Press the desired pad to select it, or tap it on the screen. Alternatively, double-tap the Pad field below the 
Program field. 

4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the 
screen and adjust the larger version of the slider that appears.  



  

 
100 

 

 

Keygroups 

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer. 

 

 

 

 

To set the send levels for a keygroup in Program Edit Mode: 

1. While using the desired program, press the desired pad to select its keygroup. Alternatively, use the Keygroup 
field at the top of the screen.  

2. Tap the Effects tab in the lower-right corner. 

3. Use the Send knobs to set the send level for each return. 

 

 

 

 

To set the send levels for a keygroup in the Pad Mixer: 

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at 
the top of the screen to select the desired track—the program it uses will be selected automatically. 

2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level). 

3. Press the desired pad to select its corresponding keygroup, or tap it on the screen. Alternatively, double-tap the 
Keygroup field below the Program field. 

4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the 
screen and adjust the larger version of the slider that appears.  
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Audio Tracks 

You can set the send levels for audio tracks in the Channel Mixer only. 

 

 
 
To set the send levels for an audio track: 

1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Audio Tracks. 

2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the desired audio track. Alternatively, double-tap the Audio 
Track field below the Mixer field. 

4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the 
screen and adjust the larger version of the slider that appears. 

 

Programs 

You can set the send levels for programs in the Channel Mixer only. 

 

 
 
To set the send levels for a program: 

1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Programs. 

2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Program 
field below the Mixer field. 

4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the 
screen and adjust the larger version of the slider that appears. 
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Submixes 

You can set the send levels for submixes in the Channel Mixer only. 

 

 
 
To set the send levels for a submix: 

1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Submixes. 

2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the desired submix. Alternatively, double-tap the Submix 
field below the Mixer field. 

4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the 
screen and adjust the larger version of the slider that appears. 
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File Formats 

Tap WAV, AIFF, MP3, FLAC or OGG to select the 
file format of the mixdown. 

For WAV and AIFF files, use the Bit Depth field to 
select a bit depth of 8, 16, or 24 bits, or 32 bits, 
floating point (32 F). For FLAC files, you can select 
a bit depth of 16 or 24 bits. For MP3 and OGG 
files, you can select a Bitrate of 128, 160, 192, or 
320 kbps. 

Use the Sample Rate field to select a sample rate 
of 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz. In most 
cases, we recommend selecting 44.1 kHz. 

 

 

 

Tap Export to enter the Save screen where you can select a name and location to save your audio mixdown. 

Tap Cancel or the  icon in the upper-left corner to return to the previous screen. 

 
 
Battery Usage 
 

Important: Only MPC Live may use battery power. MPC X and MPC Touch must be connected to a power outlet. 

Although you can power MPC Live from a power outlet (using the included power adapter), you can use its 
internal battery, which typically has four hours of life, depending on CPU and how you’re using MPC Live. 

While powering MPC Live from its internal battery, the battery icon in upper-right corner of the touchscreen 
will show its current battery life. (The icon below it indicates whether MPC Live is in Standalone Mode or 
Controller Mode.) 

 

To view MPC Live’s system resources (battery life, CPU, 
and RAM usage), tap the battery icon in upper-right 
corner of the touchscreen. The System Resources window 
will appear, showing percentages to indicate the current 
battery life, CPU, RAM usage (Mem), and storage device 
space usage. 

See System Resources to learn more about the information 
shown in this window. 

 

To charge MPC Live’s internal battery, connect its power 
input to a power outlet using the included power adapter. 
The charging indicator light (behind the vent on the rear 
panel) will turn on while charging. When the battery is fully 
charged or when it is disconnected from a power outlet, 
then this light will turn off. 
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When viewing the track channel strip while using an audio track: 

The first field defines the input source of the external audio signal, which you can 
set to a pair of inputs (Input 1,2–3,4 in Standalone Mode, Input 1,2–31,32 in 
Controller Mode) or a single input (Input 1–4 in Standalone Mode, Input 1–32 in 
Controller Mode). 

The second field shows where the track is routed, which you can change: Out 
1,2–7,8, Out 1–8 or Sub 1–8 in Standalone Mode; and Out 1,2–31,32 or Out  
1–32 in Controller Mode. 

Note: When set to a mono channel, the left and right channels are summed 
post-pan knob. If the pan knob is set to the center position, the left and right 
channels will be summed and padded. If the pan knob is set to the maximum 
left or right positions, only the respective channel will be sent to the output. 

The Inserts field shows any enabled or disabled effects for that track. Tap the 
area under Inserts to open a window where you can load, change, and enable 
or disable the effects. 

Tap Solo or Mute to solo or mute the track (respectively). Alternatively, press 
Solo or Mute under the LED meters (MPC X). 

To change the audio track’s automation, tap the track automation button 
or press Read/Write (MPC X) to cycle through its three states: 

When off, the audio track will ignore automation data. If you have already 
recorded or entered automation, tapping this will switch between Read (R) 
and Write (W) only, but you can override this and turn it off by pressing and 
holding Shift while pressing or tapping the button. 

Important: If you have already recorded automation and turn it off, the 
track will still use the effect and its parameter values at the point where you 
turned it off. 

When set to Read (R), the audio track will read automation data but will not 
record any additional automation over it. (Think of this as a protective 
feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the audio track can record automation. (If you have 
any Q-Link knobs assigned to automatable parameters, make sure not to 
touch any accidentally while you are recording.) 

Tip: You can quickly set all programs and audio tracks to the same 
automation by tapping the global automation button in the upper-right corner 
of the screen. See General Features > Automation to learn about this. 

Adjust the pan knob or level slider to change the panning or level of the track. 
The green level meter next to the slider shows the track’s current volume level 
in dB. 

To record-enable the track, tap the Record Arm button or press Rec Arm 
(MPC X). When you begin audio recording, the audio signal will be recorded to 
this track. 

Tip: You can select multiple tracks in the Track View by pressing and holding 
Shift while tapping the Arm button to each track. 

 
When viewing the master channel strip: 

The first field shows the current master output as a stereo pair (which you can 
change). 

The Inserts field shows any enabled or disabled effects for that pair of outputs. 
Tap the area under Inserts to open a window where you can load, change, and 
enable or disable the effects. 

Tap Mute to mute the master output. 

Adjust the pan knob or level slider to change the panning or level of the master 
output. The green level meter next to the slider shows the outputs’ current 
volume level in dB. 
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Step Sequencer 
 

The Step Sequencer lets you create or edit sequences by using the pads as “step buttons,” 
simulating the experience of a traditional step-sequencer-style drum machine. This is 
available for MIDI tracks only, not audio tracks. 

You can also create and edit automation using the Step Sequencer. See Appendix > 
Updates in v2.6 > New Features > Step Automation for more information. 

 

To enter the Step Sequencer, do either of the following: 

• Press Menu, and then tap Step Sequencer. 

• Press Step Seq (MPC X). 

 

 

 

 

The top of the screen shows the track name and information as well as sequence and timing information. 

 

 

 

 

The Track field shows the name of the current track. 

 

 

Use the Track Length field to set how long the track is. If you select the minimum value, Sequence or 0 (if you use 
the numeric keypad), the track will be the exact same length as its sequence. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence 
repeatedly under a 4-bar bass line. 

 

 

Use the Bars field to adjust the length of the sequence in bars. 
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Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo (Seq) or a master tempo (Mst), tap the 
Seq/Mst button next to the BPM field. Alternatively, press Shift+Tap/Master. 

 

 

The time counter at the top of the screen indicates the current playhead position. This is shown in 
most of the modes. See General Features > Time Counter/Locate to learn about this.  

 

 

Use the Time Division selector to set the value that determines how many steps each bar of the sequence will have. 
The T indicates a triplet-based value. 

Alternatively, tap TC at the bottom of the screen to open the Timing Correct window. See General Features > 
Timing Correct (TC) to learn about this. 

 

 

 

 

To enter or delete steps in a sequence: 

1. Use the Pad –/+ buttons at the bottom of the screen to select the pad whose steps you want to enter or delete. 
The current pad number is shown in the upper-left corner. 

Alternatively, use the Pad Select feature: Tap and hold Pad Sel, press the desired pad, and then release Pad 
Sel. You can also use Pad Select as a “latching” feature: tap Pad Sel so it is activated, press the desired pad, 
and then tap Pad Sel once more so it is deactivated. 

2. Use the Bar –/+ buttons at the bottom of the screen to select the bar of the sequence whose steps you want to 
enter or delete. The current bar number is shown in the upper-left corner. 

3. Press the pads of your MPC hardware, or tap a button at the bottom of the sequencer. Each pad corresponds to 
a step in the bar and will light with a color corresponding to its velocity. 

Keep in mind that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In 
this case, use Pad Bank Buttons A and B to view all the steps within a bar. 

 

For time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In 
this case, use the left and right arrows (< and >) by the step numbers (1–16, 17–32, etc.) to 
change which steps are shown in the sequencer. 

Alternatively, use Pad Bank Buttons A and B. 
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To adjust the velocities of the steps, do any of the following: 

• Tap anywhere on the velocity bar of a step. The top of the velocity bar will jump to that point. 

• Use the slider on the right edge of the screen to increase or decrease the velocities of all steps. 

• Turn the Q-Link knob that corresponds to that step (the Q-Link knobs must be in the Screen edit mode). 
Setting a value of 0 (Off) will delete the step. 

 
 

Use the Nudge < and Nudge > arrows to shift each step left or right (respectively) one step. This is useful for 
experimenting with different rhythmic permutations. 

 

 

Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.  

 

 

Use the Flip Steps button to switch which steps have notes entered and which do not have notes. 
Steps that previously had no notes will now have notes at full velocity (127). Steps that previously had 
notes will now be empty. 

 

 

Tap Presets to show or hide the preset sequence controls. These controls let you manipulate and 
transform the velocities of the current bar in the sequence. 

 

The first button will apply ascending or descending velocities to the steps. Each time you tap it, it will 
cycle through these options: 

• The velocities will ascend to a single peak at the end of the bar. 

• The velocities will ascend to two peaks—one after each half of the bar. 

• The velocities will ascend to four peaks—one after each quarter of the bar. 

• The velocities will descend from a single peak at the start of the bar.  

• The velocities will descend from two peaks—one after each half of the bar. 

• The velocities will descend from four peaks—one at the start each quarter of the bar. 

 

The second button will set the velocities of the steps to be at the maximum value (127) or minimum 
values (1), depending on their position in the bar. Each time you tap it, it will cycle through these options: 

• The velocities of the first half of the bar will be set to 1. The velocities of the second half will be 
set to 127. 

• The velocities of the first and third quarters of the bar will be set to 1. The velocities of the 
second and fourth quarters will be set to 127. 

• The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 1. The 
velocities of the second, fourth, sixth, and eighth eighths will be set to 127. 

• The velocities of the first half of the bar will be set to 127. The velocities of the second half will 
be set to 1. 

• The velocities of the first and third quarters of the bar will be set to 127. The velocities of the 
second and fourth quarters will be set to 1. 

• The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 127. The 
velocities of the second, fourth, sixth, and eighth eighths will be set to 1. 
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The third button will apply ascending or descending velocities to the steps. Each time you tap it, it will 
cycle through these options: 

• Across the entire bar, the velocities will ascend to a peak and then descend from it.  

• In each half of the bar, the velocities will ascend to a peak and then descend from it. 

• In each quarter of the bar, the velocities will ascend to a peak and then descend from it. 

• Across the entire bar, the velocities will descend from a peak into a valley and then ascend back 
up to the peak. 

• In each half of the bar, the velocities will descend from a peak into a valley and then ascend back 
up to the peak. 

• In each quarter of the bar, the velocities will descend from a peak into a valley and then 
ascend back up to the peak. 

 

The fourth button will swap the first half and second half of the bar. In other words, the first half of the 
bar will become a mirrored image of the second half, and vice versa. 

 

The fifth button will invert the velocities of all steps with entered notes. The sum of the old and new 
velocities will equal 127. The exception is a velocity of 127 or 1 as a step with a note cannot have a 
velocity of 0. 

Examples: 

Steps with velocities of 40 will now have velocities of 87, and vice versa. 

Steps with velocities of 75 will now have velocities of 52, and vice versa. 

Steps with velocities of 127 will now have velocities of 1, and vice versa. 
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Step Automation 
 
You can now input, view and edit automation in the Step Sequencer. 

 

 

 
To add a step automation parameter: 

1. Open the Step Sequencer by doing either of the following: 

• Press Menu, and then tap Step Sequencer. 

• Press Step Seq (MPC X). 

2. By default, the Parameter field of the Step Sequencer displays Velocity for MIDI programs and PRG: Volume 
for audio programs. Double-tap this field to open the drop-down menu. 

3. In the menu that appears, tap Add New to add an automation parameter. You can choose from a variety of 
parameters depending on the type of program, insert effects added and other options. 

 
To edit step automation, do any of the following: 

• Tap and drag your finger in the step area to freely draw step values. 

• Press and hold the Q-Link button, and then tap Screen to set the Q-Link knobs to Screen Mode. While viewing 
the step sequencer, you can use the Q-Link knobs for tactile control of each step's automation value, emulating 
traditional knob-based step sequencers. While it is being adjusted, the current automation value will be shown 
next to the Parameter field, as well as in the display strip above the knobs (MPC X only). 

For MPC Live and MPC Touch, use Bank 1 of the knobs to control Steps 1–4, Bank 2 to control Steps 5–8, 
Bank 3 to control Steps 9–12 and Bank 2 to control Steps 13–16. 

• Press and hold Shift and tap Clear to clear all automation for the selected parameter in the selected sequence. 

• Press and hold Shift and tap Clear Bar to clear all automation for the selected parameter in the current bar of 
the selected sequence. 

• Use the Nudge < and > buttons to shift the current automation parameter to the left or right at the current Timing 
Correct value. 

• Use the slider on the right edge of the screen to increase or decrease the parameter values of all automation 
steps in the visible time range. 

• Tap Presets and use the buttons to apply the presets to the step automation (See Operation > Modes > Step 
Sequencer for more information). 

 
Note: When editing step automation, if a step is not activated, a darkened step bar will indicate the current 
parameter value at that step, based on the last active step. 
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Submixes 
 
MPC X and MPC Live now contain 8 submixes in Standalone Mode for additional track and program routing options. 

 

 

 
To assign an audio track or program to a submix: 

1. Press Menu, and then tap Channel Mixer. Alternatively, press Ch. Mixer (MPC X only). 

2. Set the Mixer field at the top of the display to Audio Tracks or Programs. 

3. Double-tap the Output field of the audio track or program channel strip. 

4. In the drop-down menu, scroll to the top of the list and tap to select Sub 1–8. The audio track or program's 
audio will now be routed to the selected submix. 

 
To edit a submix: 

1. Press Menu, and then tap Channel Mixer. Alternatively, press Ch. Mixer (MPC X only). 

2. Set the Mixer field at the top of the screen to Submixes. 

3. Use the mixer grid to select a submix, and then use the channel strip on the left side of the screen to add effects 
or adjust level, pan and other parameters. 

 

 

Workflow Enhancements 
 

The Keep or Discard window in Sample Record Mode and the Export Loop as Sample window in Looper Mode 
now have easy-access buttons to Save or Edit the recorded sample or loop. 

 

In Sequence Edit Mode, you can now copy events from individual or multiple pads or notes from the Copy Events 
window. 

 

In the Sequence Edit > Copy Sequence and Track Edit > Copy Track windows, you can now rename the 
destination sequence or track. 

 

The FX list can now be sorted by type of effect for easier navigation. 

 

Timing Correct can now be applied to all tracks by pressing the All Track button in the Timing Correct window. 
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